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1.

Preface
This documentation is intended to assist you in the
installation of your ACS10 software program; it is
not an operating manual.
For operating the software program, the ACS10
Help is at your disposal. Refer to chapter 6 of this
manual for details.
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2.

Introduction

2.1 What is ACS10 software program?
ACS10 is a software program used for data readout and parameter settings in M-bus plants. The
data can be read from the memory of the OZW10
M-bus central unit or from a memory card inserted
in the OZW10. ACS10 also facilitates the recording
of measured values that are made available by the
M-bus central unit.
Data stored on the memory card can be read and
also deleted with the ACS10 software program.
The connection to the M-bus central unit can be
established directly with the help of a null modem
or via a telephone modem.

2.2 Contents of ACS10 software package
Your ACS10 package contains:
- 3½” diskettes (1.44 MB)
- the manual

2.3 Requirements on the system
2.3.1 PC, hardware and software
To be able to work with ACS10 and to establish a
connection to a M-bus central unit, your PC must
meet the following requirements:
- PC: 100 % IBM compatible
- Processor: 80386 min., but 80486 recommended
- RAM: 4 MB min., but 8 MB recommended
- Memory required on hard disk: 6 MB min.
(depending on the number of heat meters)
- Screen: VGA standard driver (VGA3.0), 640 x
480, 16 colors
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-

-

Interface: At least one serial interface with up to
9,600 baud
Operating system:
- DOS version 5.0 or higher and WINDOWS
version 3.1 or higher, or
- OS/2, version 2.1
3½” diskette drive, 1.44 MB

2.3.2 Accessories
For direct
connection:

-

For modem
connection:

-

Standard RS232 cable, one-to-one-termination
Note:
Depending on the PC interface, you may also
need a reduction adapter (commercially
available, to provide reduction from 25 to 9 pins,
or vice versa). Please check whether the PC
interface and the cable use the correct
connectors
Null modem
One modem for the M-bus central unit and one
for the PC
Connecting cable between PC and modem
(standard RS232 cable, one-to-one-termination)

2.4 Tips on the use of the manual
2.4.1 Terminology
The terms "menu" and "menu choice" have the
following meaning:
1

1
2

Menu
Menu choice

2
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2.4.2 Naming of PC keys
Please note:
[SHIFT] + [CTRL]

The plus sign separating the
two key names denotes that
both keys must be pressed at
the same time.

[SHIFT]

Uppercase letters are also
used on the keys themselves.

[Direction keys]

Lowercase letters are not used
on the keys. Press the keys as
indicated in the manual.

This manual uses the names of the American
keyboard.
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3.

Installation

3.1 Installing the software
Note:
During installation, you can work with the default
settings.
To load the ACS10 software program from the
diskette to your hard disk, proceed as follows:
1.
Start WINDOWS
Caution:
If WINDOWS already runs, stop it and start
it again before beginning with the installation
of ACS10. This procedure avoids installation
problems.
2.
Place the first ACS10 diskette in drive A: or B:
3.
Select "Execute..." from the "File" menu
4.
Enter the command:
a:\setup.exe or b:\setup.exe.
5.
Press the "OK" button.

3.2 Installing the hardware
For installation of the hardware, refer to chapter 4.,
"Connecting the M-bus central unit".

3.3 Setting the connection parameters
3.3.1 Configuring the communication
You define the type of connection between the Mbus central unit and your PC via the COM interface
by selecting "Communication..." from the
"Configuration" menu.
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This window allows you to define the type of connection for the
individual COM interfaces.

3.3.2 Drivers
Communication
without modem

Please select the preconfigurated driver
"OZW10 Direkt":

Communication with
modem

For the following types of modems, drivers are
preconfigured:
- Alcatel md1142
- Microlink 2440TL
- Microlink 2460TL
- Microlink 28.8TQV
- Microlink 28.8TQ
- Microlink 14.4TQ
- QuickTel XEBA 14.400
- Worldport 2400
- Worldport 2400 V.42bis
- Zyxel U-1496
- Zyxel U-1496E
Please contact us if other drivers are required.
For other types of modems, it is necessary to
define specific drivers. In particular, please ensure
that in the initialization modem string the following
parameters will be set as indicated (provided they
are supported by your modem):
- Selction of error correction: NORMAL
- Automatic resynchronization: OFF
- Data compression: OFF
- Data buffering in the negotiation phase: OFF
- Bit rate on telephone side: %B9600 (central unit
and PC)
We recommend to use one of the modems listed
above, since the ACS30 has been tested with them.
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4.

Connecting the central unit

4.1 Settings at the M-bus central unit
When switching on, the data are set to the status
as supplied.
The following variables and values must be
entered into the M-bus central unit:
- Direct connection/modem connection
- Code number
This is made as follows:
Where to make the

As

setting:
Page 4, line 48:
"Selection PC
interface"

supplied
2

Page 09.1 (only
available on
ACS10!):
Line "Code number"

0000001

What to enter:
1 = modem connection
2 = direct connection
The code number must
agree with the selection
made in the ACS10 window "Edit plant directory"

4.2 Connection without modem
To establish a connection to a M-bus central unit, a
null modem (refer to section 4.4., "Null modem") is
required between PC and M-bus central unit.
The following illustration shows the direct
connection between PC and M-bus central unit.

2

1
2
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4.3 Connection via modem

1
2

RS232 Cable
Modem

Normally, with an OZW10 M-bus central unit as
supplied by Landis & Staefa, you can establish a
connection via modem, in which case you only
need to enter 1 on operating page 4, line 48,
"Selection PC interface".
If your modem does not operate with the default
settings, you need to change the settings
contained in the tables below to suit your modem.
These settings can only be made via the ACS10.
For this purpose, you need to establish a
connection first (refer to section "4.3., "Connection
without modem").
In the "Operating pages" window, you can then
change the settings to suit your modem, page 9.1,
"Configuration of M-bus central unit".
Note:
To be able to select this operating page, you need
to change to "Options - Select pages Configuration" (refer to Help under "Operating
pages").
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~~AT&F ^M
ATDP
~~~~+++~~~~ATH ^M

Modem-String für ATDP
Wählen

Modem-String für ~~~~+++~~~~ATH ^M
Aufhängen

1200

Modem-String für AT&F ^M
Reset

2400

Baudrate

0000001

~~ATE0V0&C1S0=2 ^M

0000001

Telefonnummer
der Leitstelle 2

0000001

Modem-String für ATE0V0&C1\J1S0=2 ^M
Initialisierung

0000001

Telefonnummer
der Leitstelle 1

Zeile:

Alcatel md1142
Microlink 2440TL
Microlink 2460TL
Worldport 2400
Worldport 2400 V.42bis
Zyxel U-1496
Zyxel U-1496E

~~~~+++~~~~ATH ^M

ATDP

AT&F ^M

ATE0\N0%E0\C0V0\J1S0=2 ^M

2400

0000001

0000001

Microlink 28.8TQV
Microlink 28.8TQ
Microlink 14.4TQ

~~~~+++~~~~ATH ^M

ATDP

AT&F ^M

ATE0V0%C0\N0&K0S0=2F8 ^M

9600

0000001

0000001

QickTel XEBA 14.400

Settings

9

4.4 Null modem
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PG

1

1

TD

2

2

RD

3

3

RTS

4

4

CTS

5

5

DSR

6

6

GND

7

7

DCD

8

8

DTR

20

20

PG
TD
RD
RTS
CTS
DSR
GND
DCD
DTR

Protective Ground
Transmit Data
Receive Data
Request to Send
Clear to Send
Data Set Ready
Signal Ground
Data Carrier Detect
Data Terminal Ready

2843Z05

To connect a PC, a standard RS232 cable and a
null modem are required. With the null modem, at
least wires 1, 2, 3, 4, 5, 6, 7, 8 and 20 must be
connected as follows:
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5.

General information on
WINDOWS
By using the combination of keys given in the table
below, you can also operate WINDOWS without a
mouse.

5.1 Combinations of keys
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Calling the task list

[CTRL] + [ESC]

Changing to the next
application without restoring
the symbolic windows

[ALT] + [ESC]

Changing to the next
application with restoring the
symbolic windows

[ALT] + [TAB]

Copying a screen shot to the
clipboard

[PRINT SCREEN]

Copying an active window
(dialog box,, application) to the
clipboard

[ALT] + [PRINT
SCREEN]

Opening the system menu in
an application window

[ALT] + [Spacebar]

Opening the system menu in a
document window

[ALT] + [-]

Closing the active window or
an application

[ALT] + [F4]

Closing a document window

[CTRL] + [F4]

Changing between window
and full picture in a DOS
window

[ALT] + [ENTER]

Shifting a window after
selecting "Shift" or "Size" from
the associated system menu.
After shifting, close with
[ENTER]

[Direction keys]

ACS10
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5.2 Dialog boxes
To the next option

[TAB]

To the previous option

[SHIFT] + [TAB]

Selecting a menu or group
whose name contains this
underlined letter

[ALT] + [Letter]

Selecting the first element or
character within a list or text
field

[HOME]

Selecting the last element or
character within a list or text
field

[END]

Opening a list

[ALT] + [Downward arrow]

Highlighting a list element or
deselecting

[Spacebar]

Extending or deleting
highlighting

[SHIFT] + [Direction key],
[SHIFT] + [HOME],
[SHIFT] + [END]

Executing a command,, with
previous selection if
necessary

[ENTER]

Closing the dialog box
without executing a
command

[ESC] oder
[ALT] + [F4]

5.3 Editing text
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Extending or reducing
highlighting by character

[SHIFT] + [Left arrow],

Extending or reducing
highlighting by character

[SHIFT] + [Upward arrow],

Extending or reducing
highlighting by one screen

[SHIFT] + [PAGE DOWN],

Highlighting text to the end of
the line or to the first
character

[SHIFT] + [HOME],

[SHIFT] + [Right arrow]
[SHIFT] + [Downward
arrow]
[SHIFT] + [PAGE UP]
[SHIFT] + [END]
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Highlighting the previous or
the next word

[CTRL] + [SHIFT] + [Left
arrow],
[CTRL] + [SHIFT] + [Right
arrow]

Highlighting text to the start
or the end

[CTRL] + [SHIFT] +
[HOME],
[CTRL] + [SHIFT] + [END]

Deleting the highlighted text
and storing it on the clipboard

[SHIFT] + [DELETE]

Copying the highlighted text
to the clipboard

[CTRL] + [INSERT]

Inserting the contents of the
clipboard at the actual pointer
position

[SHIFT] + [INSERT]

Retrieving the last working
step

[ALT] + [BACKSPACE]

5.4 Program manager
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Moving between individual
windows and symbols

[CTRL] + [F6], or

Starting the highlighted
program

[ENTER]

Side-by-side arrangement of
opened individual windows
("Tile")

[SHIFT] + [F4]

Cascaded arrangement of
opened individual windows
("Cascade")

[SHIFT] + [F5]

Closing the active group
window

[CTRL] + [F4]

Closing the program manager

[ALT] + [F4]

Editing a program property

[ALT] + [ENTER]

[CTRL] + [TAB]
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5.5 File manager
Opening a file
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[ENTER]

Shifting files and directories

[F7]

Copying

[F8]

Deleting

[DELETE]

More detailed information
(properties)

[ALT] + [ENTER]

View of next level

[+]

Showing branch

[*]

Removing branch

[-]

Showing all levels

[CTRL] + [*]

Cascaded windows

[SHIFT] + [F5]

Windows side-by-side

[SHIFT] + [F4]

Updating directory trees

[F5]
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6.

ACS10 Help
Detailed instructions about functions and operating
sequences are given in the help program.
For this reason, this manual does not contain
detailed operating instructions on the ACS10
software program.

6.1 The first steps
A description of the most important procedures is
given in ACS10 Help. Select "Contents" from the
"Help" menu to reach the first help page.
From there, you can select "Procedure".
Now you can invoke help text for the various
actions.

6.2 Invoking ACS10 Help
ACS10 Help can be invoked in different ways:

6.2.1 Function key F1
Using function key F1, you can access ACS10
Help. A description of the respective window will
then be given.

6.2.2 "Help" menu
In the main menu, you will find the "Help" menu.
You can invoke it at any time. The menu choices
have the following meaning:
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"Contents"

Calls up ACS10 Help, which is
operated the same way as any
other help program of a
WINDOWS application.

"Search..."

This menu choice calls up the
dialog box "Search". Here, you
can search for certain terms
relating to ACS10 and the Mbus central unit.

ACS10
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"Using Help"

This invokes the help program
of WINDOWS.

"Info..."

Shows you in a dialog box
information relating to your
software program. This
includes the version number,
the build number and the date
on which the software program
was produced.
If you contact us for
assistance, please provide this
information.

If you do not use a mouse, you can work with the
keyboard codes listed in chapter 5. "Combinations
of keys".

6.3 Printing help texts
If you wish to print certain sections of the help
texts, you can do so by selecting "Print theme"
from the "File" menu.
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7.

Rectification of faults
Should faults occur, please check the following:
• Is the RS232 cable connected to the defined
COM interface?
• Have all phone numbers been correctly
selected?
• In the case of a direct connection, is there a null
modem connected between the RS232 cable
and the M-bus central unit?
• Has the connection to the respective COM
interface been correctly defined? (Refer to the
"Configuration" menu and the menu choice
"Communication...").
• Are the system requirements met? (Refer to
section 2.3. "System requirements").
• Did you select the right plant?
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8.

Archiving data
We would like to draw your attention to the fact
that the data you handle in connection with the
ACS10 software program must still be accessible
after a year's time.
To ensure the data will still be available after that
period of time, we recommend to proceed as
follows:
• Save your data according to a backup concept.

• Ensure that you save the data in a format that
allows you to rehandle them at any time.
Use the quick names from the plant directory as a
subdirectory for the files.
For example:

Note:
The memory card files are saved in the
subdirectory MEMOCARD. We recommend to
create some more subdirectories (e.g. by using the
production numbers of the M-bus central units as
the directory names) and to copy the files to these
subdirectories.
ACS10 stores the data as follows:
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9.

Support

9.1 General notes
Should you run into problems with either the
hardware or the software, consult the manual first.
If you find no advice relating to your problem,
ACS10 Help will probably assist you, depending on
the type of problem (refer to chapter 6. "ACS10
Help"). If your problem can still not be overcome,
please talk to your M-bus contact person at the
Landis & Staefa service center nearest you.

9.2 Information on support
If you contact your Landis & Staefa service center,
please have the following information available:
- License number (you find this on the diskette)
- Version and build number (see in the "Help"
menu under "Info..." or on the diskette)
- Precise wording of the error message
- Type and software version of the M-bus central
unit
- Type of modem
- Type of your computer
- Type of operating system and version of DOS
and WINDOWS
- Contents of your CONFIG.SYS and
AUTOEXEC.BAT files
This information will enable us to resolve your
problem in the fastest way.
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10. License agreement
10.1 General notes
When you purchased the ACS10 readout software
program, you/your company have/has signed a
licence agreement, which defines the buildings
covered by the agreement.
Prior to using the program, please make certain
that you/your company have/has obtained the
license agreement for the right field of application.
Violations may lead to considerable claims for
damage and may result in prosecution.
If you have any questions concerning to your
license agreement, please get in touch with your
ACS10 contact person.

10.2 What is permitted
-

Istallation and operation of the software program
on a PC of the company that has signed the
license agreement
Readout of data from the buildings that are
covered by the license agreement

10.3 What is not permitted
-
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Transfer of software copies or printed
information to thirds
Readout of data from buildings that are not
covered by the license agreement
Reverse engineering, decompiling or
disassembling the software program
Renting or transferring the software program to
thirds

ACS10
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11. Additional operating cards
11.1 General notes
The ACS10 software program allows you to make
additional settings that cannot be made at the Mbus central unit.
You can operate the OZW10 M-bus central unit
from a remote location via the menu "Data Remote operation - Operating cards". The
operating cards are assigned to two levels:
1.
At the standard level, you find operating
cards 1...4 as on the OZW10 M-bus central
unit, plus the extra card "Commands" and
"Clock time meter".
2.
At the configuration level, you find additional
operating cards that, usually, are only
required for commissioning the system. The
settings at the configuration level should
only be changed by authorized staff.

11.2 Standard level
On the "Data" menu under the menu choices
"Remote operation - Operating pages", you find
operating cards 5.1, "Clock time meter", and 8.1,
"Commands", in addition to operating cards 1...4.
Operating card 5.1, "Clock time meter", allows you
to:
- Read out the date
- Read out the clock time of the meters
Operating card 8.1, "Commands", allows you to:
- Acknowledge error messages
- Format the memory card
- Synchronize the meter clocks with the clock time
of the M-bus central unit
Acknowledgement, formatting and synchronization
are made by setting the displayed value from 0 to
1. After performing the function, the value will
automatically be reset to 0.
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11.3 Configuration level
On the "Options" menu in the "Operating pages"
window, you find the menu choice "Select pages"
and then the "Configuration" option which allows
you to access the additional operating card 9.1,
"Configuration M-bus central unit".
On operating card 9.1, you find:
• The settings for summer-/wintertime changeover.
The settings of month, day, weekday, and hour
define the earliest possible time at which
changeover can take place.
For example:
The earliest possible changeover to summertime
be Sunday, March 25, at 02.00. This requires the
following inputs:
Month:
2
Day:
25
Weekday: 7
Time:
2

• The settings for communication and the
parameter settings for the modem.
Setting "Code number" can be used to ensure
access protection for the M-bus central unit from
unauthorized readout or other modem users.
If you change the code number, please
remember to write the new number down,
because no communication will be possible
without the code number!
The other settings are described in the chapter
"Connection with modem".
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